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• The ELISA technique is extremely powerful, permitting researchers to check for a variety 
of macromolecules both in a test tube and in cells via the use of antibodies. 

• Antibodies come in a variety of forms.  The one we will be examining in lab is the IgA 
antibody, commonly seen in saliva and nasal secretions as part of the bacterial suppressing 
action of these secretion.  

• Via technology, antibodies to antibodies have been developed (anti-Iga) and even linked 
with other enzymes like Horse Radish Peroxidase (HRP, yielding anti-IgA-HRP).   

• While initially quite confusing, the role of antibodies and various reagents used in an 
ELISA test can be very revealing. Color development solution, blocking agents, buffers and 
wash solutions are a few of the more common solutions used in ELISA assays.  

• From home pregnancy tests, to cutting edge assaying for everything from cancer cells to 
viruses, ELISA tests (and their derivatives) are found throughout biotechnology.  

• You will practice creating a standard curve and by participating in an on-line tutorial from 
the Howard Hughes Medical Center 

• Using a real standard curve and appropriate dilutions, the amount if IgA in your saliva will 
be determined.  

For more information on the College of the Canyons Introduction to Biotechnology Course, contact       
Jim Wolf, Professor of Biology/Biotechnology at (661) 362-3092 or email:  jim.wolf@canyons.edu 
 
 



I. Objectives:  
1. Visit a website to further explore ELISA theory and practice by conducting a virtual 

ELISA on line.  
2. To use an ELISA assay to find the concentration of IgA in human saliva.   
3. To understand the structure and the binding of antibodies. 
4. To understand the function of the linked enzyme in this assay.  
5. To understand a "standard curve" - and find the concentration of an unknown sample 

by comparison with known standard samples. 
6. Revisit steps in protocol to identify sources of possible errors associated with the 

protocol.  
 
II. Background: 
 
This experiment is similar to analytical tests done in laboratories all over the world.  The ELISA assay is 
used to measure very small amounts of almost any substance.  ELISA is an acronym for: 
 
Enzyme-Linked ImmunoSorbent Assay 
 
 In order to understand what an ELISA is and what it is used for, a little background information 
about assays, enzymes, and antibodies would be helpful.   
 

An “assay” is a test to determine if a specific component is present in a sample substance and 
how much of that component there is.  A hundred years ago during the gold rush, gold nuggets were 
“assayed” to determine the percentage of gold present in them. 
 
 An “enzyme” is a protein molecule that catalyzes, or speeds up, a very specific chemical reaction.  
With an enzyme present, a specific reaction can occur 100 million times faster than without the enzyme.  
Therefore, “enzyme-linked” refers to the fact that an enzyme is chemically attached to the antibody 
molecules that detect the specific component that we are testing for in a sample.  The enzyme used in an 
ELISA catalyzes a reaction that produces a colored product that we can see.  The amount of color 
produced is proportional to the amount of substance being detected. 
 
 The term “immuno” is part of this procedure’s name because it refers to the use of immune 
system molecules, specifically antibodies, in the detection process.  The ELISA reactions are carried out 
in shallow depressions, or “wells”, molded into small, rectangular plastic plates.  The term “sorbent” 
describes an important part of the procedure that involves the adhesion (adsorption) of antibodies to the 
plastic wells. 
 
 Antibodies are proteins, molecules made of long chains of amino acids, which are folded into 
particular shapes to be active.  Antibodies are “Y” shaped in structure.  Variable regions in the arms of the 
“Y” are where an antigen binds.  An antigen is a specific substance recognized by the antibody.  The 
variable regions bind only one specific antigen, and there are different antibodies for every antigen.  In 
this experiment, the level of IgA in saliva will be measured, so IgA ca be viewed as an antibody or an 
antigen depending on where it occurs in the reaction sequence! The structure of an antibody and the 
location of the antigen binding sites are shown in the figure below:  
 

    Figure 1.  Antibody structure (general) 
 
 
 



 
Another example of an antigen would be a protein on the outside of the mumps virus.  Once someone has 
had the mumps, or been vaccinated, his or her immune system will create antibodies that specifically 
recognize (bind) the mumps virus, and they alert other immune cells to destroy the virus.  That way that 
person will never have the mumps again! 
 
ELISAs are a big improvement over most types of chemical tests because:  

1. An antibody can be made to any substance.  
2. The antibody is very specific for just one substance.  Antibodies can also be antigens to other 
antibodies.  This allows for antibodies themselves to be detected and quantified, a crucial issue 
when assessing the health of the immune system (as in AIDS, leukemia and other immuno-
suppressed patients).  
3. The target can be detected in very low amounts in a small sample.  
4. The assay can be mechanized. Robots have been developed that perform the entire ELISA.  
5. The ELISA is economical because it uses small volumes of reagents and many samples can be  
    assayed on one micro-titer plate.  

 
In our ELISA assay we can choose the antibody, and that will determine what the immunoassay 

detects. In this experiment, we will determine the concentration of human IgA antibody in saliva.  
Therefore, our antigen is ALSO an antibody, which can be a little confusing.  The IgA antibody is a 
protein produced in response to pathogens and other "foreign" substances coming in contact with the 
gastro-intestinal tract.  The IgA antibody is often one of the antibodies that increases when an individual 
is responding to a bacterial or viral infection, or when oral vaccines are ingested.  Therefore, the level of 
IgA can be used to help determine if someone is fighting an infection.  However, the daily concentration 
of IgA varies tremendously in any individual, and depends primarily on how much saliva has recently 
been produced and the hydration state of the individual.  Don't be alarmed if your IgA value determined 
today is low or high; as it does not reflect the long-term viability of your immune system.  
 
Theory of the ELISA Reaction: 

 
There are a number of different methods that utilize antibodies in an immunoassay, but we will be 

using the enzyme-linked immunosorbant assay, or ELISA.  The assay scheme is depicted in Figure 2.   
 
 
 
 
 
 
 
 
 
 
 
 
 

   Figure 2.  The ELISA assay scheme 
 
 In this assay, a plastic well is first coated with a "capture" (or primary) antibody (anti-IgA, which 
is specific for the antigen.  Second, a sample containing the antigen (substance to be detected) is added to 
the well.  In this lab, this antigen is actually an antibody or IgA. The antigen will be bound by the capture 
antibody, while other molecules remain in solution.  Third, the well is washed free of unbound molecules, 
and a second, enzyme-linked antibody (secondary antibody) is introduced (Anti-IgA-HRP).  This 
enzyme-antibody is also specific for the antigen and binds to the "captured" antigen to form a "sandwich".  
Fourth, the excess antibody-enzyme conjugate is washed away.  Then a colorless substrate is added, 
which is converted by the attached enzyme to a colored product that may be measured by a 
spectrophotometer (AKA Microplate Reader). 



 
 
 
 
 

Antibody-Enzyme conjugate.  The enzyme-labeled antibody is formed by covalently linking an 
enzyme called horseradish peroxidase (HRP) to the antibody with gluteraldehyde.  This conjugate retains 
both enzyme activity and antibody binding ability.  The enzyme portion converts the colorless substrate 
o-phenylenediamine (OPD) to a colored product, which is measured at a wavelength of 405 nm. The 
reaction is shown in figure 3 below. 
 
 
 
 
 
 
 
 
 
 

         Figure 3.  Conversion of OPD to a soluble colored product. 
 
STANDARD CURVE 
 

Because of the large number of steps in the assay and the variability in reagents, a standard curve 
must be constructed with every batch of samples.  The standard curve is made with samples of known 
IgA concentration, so that it can be used to determine the concentrations of IgA in unknown samples.  It 
really is a curve, not a straight line, although there is an area that is nearly linear, and that is where the 
most accurate measurements are made.  As the IgA concentration increases, so does the concentration of 
the secondary antigen bound and the amount of enzyme present to catalyze the reaction that creates the 
colored product.  Therefore, the color intensity is proportional to the IgA concentration; the more IgA 
present, the darker the color.  The color intensity of a sample is determined by using a spectrophotometer, 
which measures its absorbance, or how strongly the sample absorbs a particular wavelength of light.  The 
more intense the color of a sample, the higher the absorbance will be.  Once the absorbance of an 
unknown sample is measured, the concentration of IgA in that sample can be extrapolated using the 
standard curve.  The standard curve is a plot of the absorbance versus IgA concentration, as shown below. 

 
 
 
 

 
 

 
 



 
 
 

III. SOP/Lab Activities: 
Lab Activities: 
1. Practice Technique: Day 1 

 
Now let’s look at the technique.  There are more steps than are alluded to here, but among the most 
crucial is the precise aliquoting of reagents and the creation of a serial dilution.  To attain accurate 
serial dilutions, a channel pipette is used.  They are really nifty and you can achieve a lot in a very 
short period of time. Also, you can screw things up in record time.  To practice this technique, load 
well A1 with 400µL of blue food coloring, B1 with green, C1 with yellow and D1 with red. Using the 
serial pipette, add 200 µL of water to each of the wells from A2-D2 through A6-D6.  The far left wells 
still have their original 400µL of undiluted dye.  
 
Now carefully add 100µL of the dyes in the first set of wells to the second set of wells immediately to 
the right.  Using the pipette tip, aspirate in and out to gently mix the solutions.  Change pipette tips and 
add 100µL of the new solutions (created by the previous mixing of 100µL of pure dyes to 200µL of 
water) to the next set of wells (A:3-D:3) What you are doing is a series of 1:3 dilutions.  You could use 
less solution, but the micro-plate reader needs at least 200 µl of liquid in it to get a good reading as the 
laser that scans the individual wells will not be accurate if the well in not full enough.  Repeat the 
process (remembering to change tips) until all of the wells have dye in them. Do all of the colors retain 
their visibility equally when diluted?  Which was easiest to see at the greatest dilution?  Now wash 
your plate out with DI water and remove the water by “whapping” the plate onto a paper towel stack 
(3-4 towels).  Save the plate for phase 3 of your experiment (below).  
 
2. ELISA Virtual Lab 
 
Introduction: 
The Howard Hughes Medical Institute website “www.biointeractive.org” will guide you through the 
process of performing a virtual ELISA test. This virtual lab will be very similar to the ELISA test you 
will perform next lab period. While going through these steps, be sure to click on any highlighted words. 
There are links throughout the virtual lab that will help you to understand what you will be doing in the 
real ELISA lab, and will help you to answer the questions at the end of this pre-lab. Performing an ELISA 
test is a very important skill in all areas of the life sciences. Don’t cheat yourself by not learning the basic 
theory behind what you are doing. If you are unsure about anything, be sure to ask questions. 
 
Virtual Lab:  NOTE..the URL may be dated, so please be sure and to tell the professor if these is a 
problem with the address, things at the site seem different, etc.   

1. Log onto www.biointeractive.org and click on “Virtual Labs” and then on “ELISA Assay”. 
2. Read “Diagnosis of Disease Based on Immune Response” and follow the link “Background” at 

the end of the page. 
3. Read “How Does This Work?” (Background). Follow link to see the figure referred to and when 

done go back by clicking on “Previous Page” at the end. When done follow link to “Lab 
Notebook” at end of page. 

4. Follow the instructions. Click on “Help” if you need help. The glossary link is helpful. 
Within each step of the virtual lab, embedded links will appear in your “Notebook”. Be sure to 
follow them. 

 
Questions: (Answers can be found in website and embedded links! If stuck, as instructor!) 

1. What is meant by “false negative” in relation to this ELISA test? 
 
 
 



2. If a patient tests positive for the particular antibody in question, does this mean the patient is 
“sick”? Explain. 

 
3. Why is it important to duplicate the test if a positive result occurred? 

(Hint: unrelated antibody) 
 
 
 

4. The secondary antibody is an antibody that is tagged or joined to an enzyme and functions in 
this test as a unit (called a conjugate). The secondary antibody in this conjugate is from a 
different species (rabbit, horse, etc.) than the primary antibody. Why is this necessary? 

 
 
 

5. Why is a serial dilution required? To put another way, why can’t we just test at one 
concentration level? (Please provide 2 reasons).  

 
 
 
 
6. Why is it important to have the spectrophotometer (Microplate Reader) filter set at the 

correct light wavelength setting before quantifying your data? (Answer is in SOP). 
 
The above questions (1-6) are FYI, and should not be turned in or included with your notebook. 
 
3. Analyzing Your Practice Microplate 
NOTE: Yes, I know that computers are confusing.  All new software is difficult, so practice and work 
collaboratively.  Try to ensure that you get some hands on time with the program.  Most biotechnology 
apparatus are computer controlled, so your patience will be worth the effort. Create a plate making a 
series of 1 to 2 dilutions of yellow food dye using the steps outlined in phase one.  You only need to 
create one series of dilutions for the below activity and create enough dilutions to go across one lane  
(so 8 total).  For the sake of comparison and simplicity, assume that the most concentrated sample 
(pure food coloring) has a concentration of 10,000 ng/ml, the next has 3,333 ng/ml, etc.  These 
dilutions are similar to the actual concentrations you will create when doing your IgA concentration 
calculations (see IgA serial dilution diagram a few pages ahead).  Also add water only to a series of 
wells next to the food coloring and remember that these are blanks.  
 
To measure the absorbance of your plate and to become accustom to looking at  generated 
computer data, complete the following: NOTE: This introduction is just to help you get 
comfortable with the technique of multi-channel pipetting, getting some data from the 
device, running the software, etc.  In reality, you would be likely looking at just one color of 
sample, one wavelength and being many more sets of samples (replicates) with blanks and 
other ideas to help make sure you date is more robust.  

1. Load plate into reader right side up and close lid.  Turn the computer attached to the 
micro plate reader. 

2. From desktop, double-click Microplate Mgr 5.2.1.  Check with instructor to be sure 
that filter setting is correct. 

3. Double-click 405-Endpoint protocol.  Ensure that the right wave length is selected.  Click 
“Run”. 

4. Close the window.  “Save changes to Plate 1/your name?”  Click “Yes”. 
5. Close Endpoint Protocol window. 
6. Open data file that were just saved. 
7. A standard curve needs to be created.  Assume that your most concentrated sample (pure 

dye) has a concentration of 10,000 and the next  has 3,333, etc.   Using Standard (S) from 



template tool bar, identify each standard well (each well which has a known 
concentration), by clicking on it individually from lowest to highest.  This should assign 
a separate number to each well. 

8. Select for the blanks by clicking the “B” (Blank) button.   
9. Under the view menu, select, “Standard Curve Report”.  A graph should appear (Do not 

worry at this point if all the points are in a vertical line.  Continue with the next step). 
10. Under the Edit menu, select Edit Standard Conc.  Enter concentration values to 

corresponding standards; also identify standard units as “ng/mL”.  Select OK. 
11. From the toolbar at the bottom of the Standard Curve report window, adjust graph axis by 

selecting the “Log-linear” which uses logarithmic values on the X-axis and linear values 
on the Y-axis.  (Note:  don’t confuse with Linear-Log) 

12. Using “Save as”  from the File menu and selecting a different name than your raw data, 
save your Standard Curve Report.  Should you need to open this again, it will open as a 
template.  Selecting “Standard” Curve Report” from the View menu will restore the 
graph.  Print a copy of your graph and a copy of your raw data report (make enough 
copies for all the  people in your group.  

13. Remove plate from reader.  
 
Now:  Look at the data and your plate.  Can you see trends in the data?  Hopefully the 
absorbance is lower in your more dilute samples.  A word of caution.  Some data may be 
unintelligible as the solutions are either too dark. The plate reader has filters in it that allow it to 
look critically at certain colors. In your actual ELISA experiment (below), all of the wells will be 
yellow, and we will set the filter for 405 nm (the appropriate wavelength for this test).  
Congratulations!  You have just completed the technique portion of the ELISA lab.  Next time in lab 
we will be doing the real thing (with some minor modifications.)  You only get one chance to do this 
right, so practice the previous technique until you feel comfortable.   
 
SOP: 
Important: Always note any addenda that are posted by the instructor. 
MATERIALS (FOR A TWO PERSON TEAM): Day 2 
 
Three 8-well-long pre-coated ELISA wells 
Squirt Bottle 
TBT Buffer (2 liters) 
20 falcon centrifuge tubes per team 
Test tube rack 
20-200 μL micropipette and tips 
A jar of Anti-IgA-HRP antibody (10 mL) 
A jar of OPD color reagent (10 mL) 
Marking Pen 
Micro Centrifuge 
A large stack of paper towels 
Two 2 mL microfuge tubes 
 
PROCEDURE 
 
1.  Obtain 8, 2 ml microfuge tubes.  Prepare one set of IgA standards per team as follows.  The 
human IgA standards are prepared at 10,000, 3333, 1111, 370, 123, 41, 14, and 4.6 ng/mL.  The 
initial IgA solution is at a concentration of 2mg/mL.  To make the 10,000 ng/mL standard, dilute 
10 µl of IgA into 2 ml of TBT (it will just barely fit!).  Each standard is a 1:3 of the preceding 
one.  Therefore, if you use 0.667 mL of the 10,000 ng/mL standard plus 1.33 mL of TBT to 



make the 3333 ng/mL standard, and simply keep repeating that dilution, you’ll have 2.00 mL of 
each standard.  Label the tubes with their concentrations and you initials.  Refrigerate if storage 
is necessary.  Remember to mix WELL between dilutions. 
 
 
 
 
 
 
 
 
 
  
 
2.  Each individual will prepare their own saliva dilutions.  Prepare dilutions as follows:  Dribble 
about 2.0 mL of saliva into a sterilized 2 mL microfuge tube.  
 
3.  Snap the lid on, and spin the samples in the micro centrifuge for four minutes to pellet any 
debris.  Do not disturb the “food” pellet that is formed at the bottom of the microfuge tube.   
 
4.  Obtain 6, 2.0 ml microfuge tubes per person.  Use the micropipettes to pipette 20 µL (0.020 
mL) of the clear saliva into 1.98 mL of TBT buffer in a falcon centrifuge tube.  Mix thoroughly 
by inverting several times.  This is a 1:100 dilution of saliva.  Repeat 2 times.  You should now 
have 3 1:100 dilutions. 
5.  Make a 1:500 dilution by adding 400 uL of the 1:100 dilution into 1600 uL of TBT buffer.  
Repeat 2 times, once from each 1:100 dilution.  Save all dilutions and label clearly with dilution 
factor and your groups initials. 
 
6.  Obtain two rows of microtiter plate (these are pre-prepared for you) and empty out the TBT 
buffer by snapping it into the sink and then slapping it upside down onto a pile of paper towels 
(this is called “whapping” and dislodges all buffer). 
 
7.  Now load the plate with your saliva dilutions and IgA standards.  First, use the micropipettes 
to pipette 0.10 mL (100 µL) of the 1:100 saliva dilution in wells A through C.  Next, pipette 0.10 
mL of the 1:500 dilution into wells D through F.  Then pipette TBT buffer only into wells G and 
H.  Use one column per person.  See following figure and note that only some of the rows have 
been prepared (to save antibody, as it is expensive).  
 

0.667 
mL 
10000 
ng/mL 
+ 1.33 
mL 

 

0.667 
ml 
3333 
ng/mL  
1.33 
mL 

 

0.667 
mL 
1111 
ng/mL 
1.33 
+mL 

 

0.6mL 
370 
ng/mL 
1.33 
+mL 
TBT 

10µL 
IgA 
+ 
2mL 
TBT 

0.6mL 
41 
ng/mL 
 1.33 
mL 
TBT 

0.6mL 
14  
ng/mL 
1.33 
 mL 
TBT 

10,000ng/mL 3333 ng/mL 1111 ng/mL 370 ng/mL 

0.6mL 
123 
ng/mL 
1.33 
+mL 
TBT 

123 ng/mL 41 ng/mL 14 ng/mL 4.6 ng/mL 



 
 
8.  In the other column, pipette 0.100 mL (100 µL) of the standard IgA solution into wells A 
through H, starting with the lowest concentration (well A) and moving to the highest 
concentration (well H).  Use one column per team.  It is not necessary to change pipette tips for 
each new concentration as long as you move from low concentration to high concentration. By 
now you should have the following (3) columns: one saliva dilution column per person and one 
IgA standard column per team. Record this info in your lab notebook. 
 
9.  Allow the samples to sit for 20 minutes.  Then invert the plate and snap the samples into the 
sink.  Immediately squirt TBT buffer into all the wells.  Do this gently; don’t get lots of foam in 
the wells.  Allow the extra buffer to drip into the sink.  Don’t worry about being sloppy and 
dripping a lot, but do make sure that the wells are filled to the top with buffer, not bubbles! 
 
10.  Allow the plate to sit for 2 minutes, and then whap the buffer out of the wells.  Wash the 
wells three more times with TBT buffer, letting the plate sit for two minutes each time and then 
whapping the buffer.  After the last wash, leave the plate empty. 
 
11.  Add 100 µL (0.100mL) of the anti-IgA-HRP conjugate to each well.  Incubate for 20 
minutes at room temperature. 
 
12.  Empty the plate by whapping, and then wash the plate four times with TBT buffer as in steps 
9 and 10.  After the last wash, leave the plate empty. 
 
13.  Add 100 µL (0.100 mL) of the OPD substrate to each well, and allow it to incubate until the 
color is formed (about 20 minutes).  Measure the absorbance of your plate using ELISA plate 
well reader (see below), 20 minutes after adding the OPD substrate.  
 
 
To measure the absorbance and create a standard curve using the ELISA well plate reader: 

a) Load plate into reader right side up and close lid.  Turn the computer attached to the 
micro plate reader. 

b) From desktop, double-click Microplate Mgr 5.2.1.  Check with instructor to be sure 
that filer setting is correct. 

c) Double-click 405-Endpoint protocol.  Ensure that the right wave length is selected.  
Click “Run”. 



d) Close the window.  “Save changes to Plate 1?”  Click “Yes”. 
e) Close Endpoint Protocol window. 
f) Open data file that were just saved. 
g) A standard curve needs to be created.  Using Standard (S) from template tool bar, 

identify each standard well (each well which has a known concentration), by clicking 
on it individually from lowest to highest.  This should assign a separate number to 
each well. 

h) Also select the unknowns by clicking the “X” (Unknown) button on the tool bar in 
the template window and then clicking on each well in the diagram that correspond to 
an unknown.  Do the same for the blanks by clicking the “B” (Blank) button. 

i) Under the view menu, select, “Standard Curve Report”.  A graph should appear (Do 
not worry at this point if all the points are in a vertical line.  Continue with the next 
step). 

j) Under the Edit menu, select Edit Standard Conc.  Enter concentration values to 
corresponding standards; also identify standard units as “ng/mL”.  Select OK. 

k) From the toolbar at the bottom of the Standard Curve report window, adjust graph 
axis by selecting the “Log-linear” which uses logarithmic values on the X-axis and 
linear values on the Y-axis.  (Note:  don’t confuse with Linear-Log) 

l) Using “Save as”  from the File menu and selecting a different name than your raw 
data, save your Standard Curve Report.  Should you need to open this again, it will 
open as a template.  Selecting “Standard” Curve Report” from the View menu will 
restore the graph.  Print graph. 

m) Remove plate from reader.  
 
 

IV. Post-Lab Questions/Activities: The following post lab questions are for your 
benefit. The questions will help you to address a range of topics relating to the lab activity. 
Along with the post lab handouts, these questions will help to ensure that you have both 
correct information regarding the lab data and crucial lab processes. Complete the post lab 
questions at the end of the lab and post lab handouts (keys for both of these are available 
from your instructor) before making any lab-notebook entries. 

 
 
1) Explain why some values on the standard may be more accurate than others. Give three 
reasons or ideas.  
2) How do your triplicate (i.e. 1:100 dilutions) values compare?  How do you account for   
discrepancies? How do they relate to the 1:500 dilutions?  Are they closer together than the 
1:100 samples?  Are the 1:500 samples giving you similar concentrations to the 1:100 samples 
(after accommodating for the dilution factor).  
3) What is the rationale behind the numerous TBT washes? 
4) Why not use undiluted saliva for IgA assay? 
5) Explain the purpose of the anti-IgA-HRP conjugate. 
6) Name two other commonly used ELISA based applications. 



 
Take Home Quiz: Pick up a copy before you leave lab.   
 
It is quite possible that you got less than optimum results.  This is often due to pipeting and/or 
washing errors.  Do not be alarmed.  It often takes skilled technician 10-15 tries to get a new 
ELISA SOP down.  Your take home quiz will address the various steps you took in this 
protocol and help to ensure you understand the rational of each step and compound. The 
quiz will also look at row data and creation of and use of a standard curve. 
 
V. Notebook Entries: Data from the lab should be the focus of this section and if there are 
any incorrect results, you should discuss this as well as expected results. Section V will contain 
both your results and discussion. Your data should drive the discussion. An informed discussion 
is dependent on understanding the post lab questions/activities. 

Your intro should: 
• Define ELISA and example uses. 
• Mention IgA as both an antibody and antigen. 
• Standards and saliva quantification with HRP/OPD system and ELISA plate 

reader/standard curve. 
Results should be: 
• Raw data report.  
• ELISA plate data legend (A1, 10,000 ng/mL, A2 333 ng/mL, etc.) 
• Computer or hand created standard curve with diluted saliva sample concentrations 

interpolated.  If you have some time, you can work with the software that comes with the 
plate reader and see if you can create a standard curve.  Unfortunately the school 
computers discard all files at each start up (of the computer), so it you want to save you 
data, etc, be sure to do so on a jump drive.  Also, you might consider taking your raw 
data and using Excel. Remember, this is a scatter plot with semi-log axis.  The 
concentration (4.1 ng/ml to 10,000 ng.ml) is log based and the absorbance is linear (0.0- 
3.0 abs, 405 nm)   

• Resulting concentration of IgA from sample data. 
Discussion should consider the following: 
• See quiz on ELISA for additional ideas. 

 
The previous lab protocol can be reproduced for educational purposes only.  It has been developed by Jim Wolf, 
and/or those individuals or agencies mentioned in the references. 
 
California Polytechnic University, San Luis Obispo.  CLUES Module 6.  Dr. Ann Rice 


	Version 9-12-12
	 The ELISA technique is extremely powerful, permitting researchers to check for a variety of macromolecules both in a test tube and in cells via the use of antibodies.
	II. Background:
	STANDARD CURVE
	III. SOP/Lab Activities:
	Lab Activities:
	1. Practice Technique: Day 1



	Take Home Quiz: Pick up a copy before you leave lab.
	It is quite possible that you got less than optimum results.  This is often due to pipeting and/or washing errors.  Do not be alarmed.  It often takes skilled technician 10-15 tries to get a new ELISA SOP down.  Your take home quiz will address the va...

